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Logic 
 

 

 

CADvizor Logic is a powerful tool that supports electronic circuit design and simulation, enabling efficient 

performance of complex circuit design and verification. Provides a variety of part libraries and tools to shorten 

design time and ensure quality through design rule checks. This guide describes the functionality and usage 

of CADvizor Logic's circuit design. 

Project 

 

The first step in the drawing design is to create a project and add a diagram. You can check the related 

menus on the Project tab and have the following functions. 

Open a project: Import the projects stored in 

 the Database, display a list, and select the project to import to the Project tab workspace. 

Create Project: 

 To create a new project as a function to create it, create it through the Create Project window. 

Importing a project: 

 Importing an extension (.cpf) file as a function to share and enter projects from other companies. 
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Project Other Features: Project Other 

 features provide the following. 

■ Close 

 Close the project in the project list. 

■ Delete Deletes the created project 

. 

■ Change the existing settings for the editing 

 project. You can re-establish names, revisions, template settings, and user privileges. 

■ Copy 

 Copy Copies an existing created project. 

■ Manage revisions of revision 

 projects. The revision is sequentially (A, B, C) (1, 2, 3) and design change history 

management can be performed efficiently. 

■ If the cleanup 

 operation does not end normally or the network environment is unstable, the project will 

not open normally, which can be normalized through the corresponding "clean up" function. 

■ You can export 

 an export project in .jcpf (JSON format) or .cpf (binary) format. It will be used to bring up 

projects in the future. 

■ Imports a project of a file saved as an import 

 cpf. 

■ Find and replace options You can change 

 

 the whole thing by finding options for the option expression specified in the circuit object 

in the project drawing. Specifying the option expression to be found will allow you to 

browse all applicable circuit objects and change and check them with new option 

expressions. 
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Add diagram: 

Create through the Create diagram window as a function to create a new diagram for the selected project. 

Print: 

 Prints all diagrams included in the selected project. 

 

Create a project 

 Create a project. For project creation, you can specify default settings for the project by default, 

settings, and user settings. 

 

Main tab 

 

When you create a project, on the Default tab, enter the name of the project. "Revision" allows you 

to systematically manage design changes during the project. Revisions allow you to compare 

changes to previous versions to prevent errors and maintain design quality. Also, if you need to 

record your project history or additional information, you can enter it in the "Description" column. 
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Settings tab 

 

Settings allow you to specify initial settings that will be applied when using circuit objects and 

graphics-related features. When creating circuit objects, you can set overall drawing styles such as 

initial name location, text size, and color. 

Project Settings 

 

■ The name location allows you to specify the location of the circuit object name that 

you want to create. You can specify up, down, and center, and a name is created at 

the location you specify for each circuit object. 

■ In line style, you can specify the style of the circuit objects that you want to create, 

such as wires, net, devices, plugs, and pins. Displayed in the drawing according to the 
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specified settings, such as dotted or solid lines, or line thickness increase or decrease. 

■ Text styles allow you to specify font styles for font circuit objects. 

■ The color set allows you to specify colors for each drawing color. Currently, CADvizor 

can specify the appearance of the drawing in three main, black, and white colors, and 

you can specify the color for each theme: dot color, selection color, and ghost color 

in the drawing. You can specify the initial color of circuit objects (devices, connectors, 

pins 

, etc.) in line color, text color, and fill color. 

■ The text size allows you to specify the size of the text that is generated when a circuit 

object is created. It is reflected as much as the value of the specified font and is 

generated in the drawing. 

■ The design proceeds with the overall setting of the drawing. Sets the initial status of 

the drawing, such as spacing between grids, paper size, horizontal zone start character, 

vertical zone start character, etc 

 

■ Wire Name tab in the display order. This tab allows you to specify which property 

values you want to line up and are reflected in order as you create the wire. Front-

back decorative characters separate the characters that precede and follow their 

properties. If you select HARCODE and add '['']' to the front and back decorations, it 

is expressed as  [H] by adding the front and back 

decorations to the harness code 'H'. 
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■ The Off-page tab lets you set the way a phrase is represented when a shared object 

(for example, WIRE2) spans different diagrams. 

 

 

For example, 

■ Page separator ':' 

■ Object separator '/' 

When set to , it is expressed as a0:P1/PIN1/WIRE2 and means "P1 connector in 

a0 diagram, WIRE2 generated by PIN1". 

 

User tab 
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The Users tab allows you to grant users permission to access the project. If you check the application, 

you will be granted permission to edit the project, and if you release it, you can't edit it, you can 

only check it. 

Add a diagram 

 

Set the diagram for which you want to configure the project. Add diagrams are divided into the 

main tab and the templates tab. 

Main tab 

Enter the name of the diagram and the wire code. The wire code specifies a representative 

circuit name, and when a wire is generated, the number increases sequentially from number 

one. By default, the wire code is designated as WIRE, and the wire is generated as WIRE1 and 

WIRE2. If WR is entered into the wire code, the wire name is created based on the wire code 

with WR1, WR2. 

Templates tab 

You can set the size and shape of the diagram. Specifies the section to be displayed in the 
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template. 

See Project-Project Creation-Project Setup-Design for more information. 

 

PDF & Paper Output 

 

You can export or print the results that you have worked on in a drawing as a PDF. PDF 

output (black and white/color) or print is possible using the button, and all activated diagrams 

must be terminated before use. You can select a template area or all areas at the output, and you 

can specify the current project or the selected design as the output range. 

Wire 

 

Wires are electrical connections that represent signal flows between symbols. One of the most 

fundamental elements of circuit design can have a variety of properties (name, color, cross-sectional area, 

material, etc.) rather than just a line. Functional elements are meaningful when used in simulation, DRC 

inspection, wire list generation, BOM linkage, etc. and logically connected to other circuit objects. 

 

Create wire (short key: W) 

There are many ways to create wires, and the way they are can vary depending on the situation. 

■ On connectors without library information, a normal pin is created and a wire is also 

created. 

■ For connectors with library information, a separate 'pin mapping' window allows you to 

select the pin to connect to, and a wire is created upon selection. 
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In addition, you can use the wire button in the wire layout at the top or use the 'W' shortcut to 

create wires, providing the following options. 

■ Press and hold the 'Shift' key and create → wires align horizontally or vertically. 

■ Press and hold the 'Ctrl' key to create a wire automatically to avoid devices on the → path. 

 

When creating a wire on the connector 

After selecting a wire in the Top Home tab or using the 'W' shortcut, left-click on the diagram 

to specify a starting point, then left-click again at the location you want to create or press 

the "Enter" key to create a wire. 

 

When you create a wire on a connector that does not have library information, the normal pin 

and wire are generated at the same time. By default, wires are generated in the form of 

"WIRE1" and pins in the form of "Pin1" and automatically change according to the existing 

wire code name in the diagram.When you create a wire on a connector with library information, 

a Pin Selection window appears, allowing you to select pins to connect to. The wire is 

automatically generated with the selected pin number. 

 

Create AutoWire 

 

When you press the 'Ctrl' key in the Wire creation state and move the mouse cursor, the 

wire automatically repositiones the devices in the path. 
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Delete the wire 

Select the wire you want to delete. You can press the "Del" key or find the "Delete" button on the 

mouse right-click menu tab and delete the selected wire from the drawing. 

 

Enter Wire Properties  

  

Wire properties consist of a general tab and a graphical tab. The way to check the properties 

window is to double-click or right-click a wire and check the properties window from the menu. 
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■ The General tab displays data values based on registered library information. At initial 

creation, the wire is created in the form "Wire1" without library information by default, and 

when you specify the library, the stored data is reflected in the wire properties. 

■ You can find more information about library properties in the Library Guide. 

■ The Graphics tab lets you edit graphics-related information, such as the color, thickness, 

and line style of the wire. 

If you have wire library information, when expressed in a drawing, the property values are displayed 

next to the name. In this case, you can specify what information you want to hide and show in the 

"View" column of the property through the checkbox. 

 

Enter the library 

 

 

You can open a library window by clicking on the library compartment. This window allows you 

to link pre-registered library information from the library module to the wire and is available in 

the Properties pane. 

 

If a library exists on the wire, the data information is displayed next to the name of the drawing 

wire, as shown in the image above. You can determine whether to display or not the data in 

the Properties pane check box. You can change the order of displaying wire property data 

information under Project-Project Creation – Project Setup-WireName. 
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Enter harness code & options 

 

 

Based on a list of pre-registered harness code items & options, you can enter that information 

into the wire properties. This allows data related to harness codes and options to be reflected 

in wire properties 

 

Option Filter 

 

The optional filter function is a value entered into the wire and allows you to add and delete 

wires according to the manufacturing specifications when manufacturing the wiring harness. 

Basically, if there is no option value, it will go in unconditionally regardless of the production 

specification. The formula symbol is as follows. 

■ "+" Formula symbol: Same as logical condition "OR". 

■ "*" Formula symbol: Same as logical condition "AND". 

■ "^" Formula symbol: Same as logical condition "NOT". 

"(", ") " Formula symbol: Determine the logical condition first of the formulas in parentheses. 
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Center strip & splice 

Center strip 

The center strip is a method of adding a new wire based on the central axis to the generated 

wire and combining it into a single path. By default, the center strip is automatically created 

when a new wire is created from the mainline wire, even if it is not selected from the Home 

tab. 

■ The name of the center strip follows the name of the wire that is being arranged, and 

the new wire is connected based on that center strip. 

■ On the Home tab, select a center strip, and specify the wire you want to create to 

create the center strip. You can continue to create ESC until you press or cancel it. 

 

Splice 

Splice is the concept of cutting the wiring from a wire and connecting the ends. You can create 

a splice on a wire by selecting it on the Home tab. 

■ Unlike the center strip, creating a splice distributes one wire into two wires. 

■ When you create a splice on "Wire1", both sides are divided into "Wire1 and Wire2" 

based on that splice. 

 

How to create a center strip 

 

The method of creating a center strip by creating a wire is shown in the figure above. If you 

create a WIRE24 on top of a WIRE23 that is already created, a center strip called WIRE23_1 is 

created. 

 

When creating a center strip on the Home tab, select the center strip button in the wire 
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layout at the top and click on WIRE23 to create the center strip. 

How to create a splice 

  

On the Home tab, under Wire Layout, select the splice button. With the splice function enabled, 

selecting a specific point above the pre-generated WIRE23 creates a splice and forms a new 

wire as shown on the right. 

 

Multi-core 

Multicore is one of the important factors when designing drawings with multicircore cables that 

combine multiple strands of wires together. Multicore elements include twists, shields, cables, etc., 

and two or more wires can be selected and used. 

■ Twist: 

 A method of twisting two or more wires together, usually used to minimize interference 

between wires, reduce signal interference, and increase the strength of wires. 

When you connect the library to the twist in Bundle Size:Logic, the outside diameter of 

the connected twisted library is used for the Bundle Size calculation and if not connected, 

the Bundle Size is calculated by the outside diameter + twist weight of each of the twisted 

wires. In addition, multicores except for the twist require a library connection, and if they 

are not connected, MFG will not include them in the Bundle Size at all and will display a 

warning window. 

■ Shield: Metallic protective film to protect signal integrity 

■ Cable: Capability to safely transfer power from one point to another when multiple wires 

are wrapped in an insulator or protective film 

Here's how to use multi-core. 

■ Select at least two applicable wires 

■ Hop Tab → Click to apply multi-core [Twist, Shield, Cable] button 

■ Multi-core is not possible with shared wire 
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Device 

 

The device displays device parts that perform electrical and electronic functions. Add parts to the circuit 

diagram, connect the wiring, and link the layout to synchronize the location information and the wiring 

path. Devices include input, output, and processing capabilities to support design tasks, allowing you to 

visualize and output designed models in physical form. The device must be pinned or pin-mapped. 

Creating a Device 

You can select the component category device button in the top menu or use the 

shortcut 'D' to create the device. After selection, the device can be placed by clicking the mouse 

"left click → left click" in the drawing. 

 

Create a connector on the device 

 

The connector can be placed on the device outline by specifying the direction you want to create. 

This allows you to align connectors to suit your circuit configuration and design wiring connections 

efficiently. 
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How to create a device pin 

Device Pin Generation 

  

Select the device that you want to generate the pin, then click the shortcut 'P'. Then, you can create 

pins in any groove you want. 

 

Automatically create device pins 

 

Hold down 'Ctrl' and automatically create pins when you create the device. 

 

Connectors 

 

It is an element that connects or interfaces various parts or objects together, which is important in 

maintaining the structural, functional, and logical continuity of the design. Provides the electrical signal 

transmission path of the circuit, defines connections between parts, defines relationships between circuit 

objects in the design, and simulates behavior. 
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Creating Connectors 

You can use  the connector button on the top component tab or use the shortcut 'C' to create 

the connector. The connector you create can be connected to the device or flexibly used as a "share" 

function. 

■ Left-click and then left-click back to the location you want to create to create a connector. 

■ When initially created, the connector is created with a name of the default form, such as 

"P1", and the name increases as much as it is created. 

■ You can add a registered library later or use the Utility-Library Hotkey feature to create a 

connector with the library present from scratch. 

■ In addition, various connector pin generation methods are provided, allowing the user to 

flexibly select and use them according to the method he or she wants. 

 

In-line connector 

An in-line connector is a device that connects two or more wires or circuits, and supports fast and 

efficient installation and connection through straight connections. The plug is connected in the form 

of a pin protruding, and the jack has a hole to accommodate the pin. These combinations provide 

interconnectivity and ensure accurate contact between connectors and wires. This method maintains 

a reliable electrical connection and provides reliable performance in a variety of environments. 

 

Create inline connector 

You can use  the buttons on the top components tab or use the shortcut 'I' to create an inline 

connector. 

  

An in-line connector can be created on a wire already located in the drawing, and pins are 

automatically generated and placed in that location based on the contact point with the wire. This 

process automatically sets up pin numbers and electrical connections, saving design time. The pin 

arrangement of the connector is automatically adjusted according to the set specifications, and 

positioning is possible after placement. The electrical connection is automatically formed so that the 

circuit diagram can be easily tracked. This enables efficient and accurate design. 
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Enter connector properties 

  

Connector properties can be accessed in two ways. 

■ Select Connector → Right-click → Properties 

■ Connectors Double Click 

The Properties pane has the General tab and the Graphics tab. 

■ The General tab provides connector connection information and library link 

functionality.Details of library property information can be 

 found in the Library. 

■ On the Graphics tab, you can edit visual effects such as color, thickness, and style. 

You can also check data values, change libraries, rename them, code harnesses in the Properties 

pane, and decide whether or not you want to show the property values in the drawing. 

 

Enter the library 
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You can open a library window by clicking on the library compartment. This window allows you 

to map library information pre-registered in the library module to the connector and verify that 

the data has been entered in the Properties window. 

 

If a library exists in the connector, the data information is displayed along with the connector 

name in the drawing. This information can be selected whether or not to be displayed through 

the check box in the Properties pane, and can be hidden or displayed as needed. This allows 

you to adjust the readability of the drawing and selectively display only the desired information. 

 

Create connector pins 

   

■ After selecting the connector that you want to generate the pin using the single pin 

generation method, press the shortcut 'P' to display the groove where the pin can be 

generated in ghost state. 

■ If the connector has a library, the "Pin Selection" window will appear, and you can specify 

which pins to generate. 

 

■ The multi-pin generation method is a method of generating multiple pins simultaneously. 
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■ When you create the connector, press and hold the "Ctrl" key to automatically create the 

maximum pin you can create. 

■ The existing method is to generate by specifying pins one by one, but this method can 

generate multiple pins at once. 

Create connector pins & wires 

This is a way that can be used when there is a connector with a pin created to help you easily and 

quickly connect pins and wires between the connectors. This feature is useful for quickly 

connecting pins and wires. 

   

1. Create and select a new P3 connector when a P2 connector with a pin is present. 

2. If the P3 connector is positioned according to the outline position of the P2 connector with 

the 'Shift' pressed, pins are created in a 1:1 format on the lines where the two connectors 

face off, resulting in a pin in P3 as well. 

3. With pins present on both connectors, press 'Shift' again and move one connector's position 

to see that a new wire is created on the pin between the two connectors. 

 

Create a shared circuit object 

Share functionality is the ability to share circuit objects (devices, connectors, wires, etc.) to improve 

design efficiency, consistency, and data management. 

How to switch share 

■ (After selecting a circuit object) Right-click → Toggle share → 

■ Alternatively, you can switch by clicking the Toggle Share  button in the top edit 

layout. 

Characteristics of shared objects 

■ Resource sharing is possible within the project. 

■ It can be created and managed in the shared list on the left menu bar. 
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■ You can link the source object and access it from multiple diagrams. 

■ Maintain data consistency and use the same element without duplication. 
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Share transition 

 

After selecting the circuit objects (wire, device, connector, multicore, etc.) you want to specify a 

share, the "Share→ Transition" option is available from the right-click menu. 

When specified as shared, the circuit object is given a special mark, and the object is 

automatically updated in the shared list so that other diagrams can share the same resources. 

 

Create share 

 

Objects converted to shared can be used at any time within the project and can be accessed 

from other diagrams, making collaboration easier. It can also be freely imported and deployed 

within the same project, helping to increase the efficiency of circuit design. Share objects can 

be found in the Data List-Share List menu on the left and can be created in a drawing by 

double-clicking on the list. 
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Data list 

 

The lower left corner of the main screen provides a menu that provides a quick, at-a-glance view of all 

projects, shared lists, symbol lists, and lists of objects in the diagram. Selecting a circuit object from this 

list allows you to immediately move to it or create a new one, and also provides the ability to manage 

harness codes and options. 

Object List 

Displays all circuit objects present in the current drawing, and is a tab that allows you to view and 

manage a list of all objects, including devices, symbols, connectors, inline, and so on at a glance. 

Double-click on an object to zoom to that location for easy management. 

 

Share list 

A list that manages shared objects, allowing you to view and use the converted shared objects within 

the project. It is accessible from anywhere in the diagram, and the right-click → Find feature allows 

you to navigate the location of the object. You can also add shared objects to a drawing by double-

clicking or right-clicking → creation. 
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a symbol list 

 

Pre-registered list of elements can be checked, including fuses, switches, ground, relays, etc. Double-

click to create it in a drawing and preview the shape of the element in the View screen at the bottom 

of the list. You can create elements on the Symbol tab of the Library tab, which are organized by 

category in the corresponding symbol list. To add elements from the symbol list, it can be configured 

directly from the symbol, and it is updated to the list after the task. 

 

harness cord 

 

Most electrical equipment are designed by defining the part where the wiring harness is assembled 

as a code, and this is called the harness code. This tab allows you to register a harness code (for 

example, harness code: A, item: MAIN) to connect the harness code type to the connector or wire. 

Click Renew code at the top of the harness code tab to call the list, and you can manage the harness 

code through the Add, Delete, and Combo boxes. Click the button  to update the harness code 

list and to  add harness code items with the button. 
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options 

  

If the wiring harness of the electrical equipment must be produced in a variety of specifications, the 

optional definition can be used to support multiple specifications of the product based on a single 

drawing. 

Small-scale electrical equipment is produced in a single specification, so no separate option setting 

is required, but if large-scale production is required, the design is carried out through options. 

CADvizor Logic allows you to define options on wires, which allows you to produce wiring harness 

products of various specifications in a single drawing. Click the button to update the list of options 

and  to add options with  the button. 

 

cycle 

 

When designing a drawing, you can use a variety of tools to provide visual effects rather than just circuit 

objects, increasing the readability of the design and delivering information more clearly. 

a line of instruction 

 

Use indicators to clearly indicate or display specific areas in the drawing. You can create a directive 

by  clicking in the Cycle Layout on the top tab, and it is available in arrow and text format by 

default. 
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a line of measurement 

 

Dimension lines are measurement information that visually represents the length, angle, radius, 

diameter, etc. of an object and are essential elements in a design drawing. It is used to deliver the 

correct size during fabrication and inspection. You can create a dimension line by clicking in the 

Period layout on the top tab, and the components of the dimension line are as follows: 

■ Dimension Mainline: Keyline indicating measured values 

■ Dimension auxiliary line: an extension that connects the dimension line to the object 

■ Dimension values: Measurements displayed on the dimension line 

 

Text 

You can create a text box in any location in the drawing. You can click in the top tab cycle layout to 

create text and  preset size, color, and font. 

 

Insert Excel  

  

This is an Excel sheet that can be created in the form of a table in the drawing.  Click in the cycle 

layout of the top tab to import the Excel table window, and you can copy data values from an 

external Excel program or add data directly to the cell. When you are done, you can create what 

you have done in the drawing by clicking the "insert in drawing" button. 
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Edit 

 

The ability to edit objects in a drawing. Use the Edit tab to make your drawing design more intuitive. 

Disconnecting the connection 

Function to disconnect the wiring elements. Select the elements you want to release and click  in 

the top edit layout to release them. Below are some examples. 

■ If the Device is connected to a Connector 

■ Wire is connected to the Connector 

■ Net is connected inside Deviec 

Disconnect the connection and switch to an independent circuit object. 

 

Grip Point  

The Add and Delete Grip Points feature can be applied to specific segments and is available by 

clicking in  the top edit layout. 

To add additional grip points, take the mouse cursor around the segment. In additional 

positions, a square-shaped grip point appears, and clicking on that position creates a grip point. 

To delete or delete, 

 you can remove a square grip point by placing the mouse cursor around the segment end 

point and clicking it when it is activated. 

 

Image 

You can  create an image by clicking a button in the edit layout at the top. Position the image 

with the first click, and resize with the second click. Supported image formats are JPG, BMP, and 

PNG. 
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Text original location 

Restore the name position of the wiring elements to the system preferences. If you want to return 

the text to its original location after changing the position of the text during drawing design, click 

the button  in the top edit layout to automatically sort the name to its existing location. 

 

Getting the end right 

A function that aligns the ends of the wires to the same position. If the ends are uneven when 

creating or managing multiple wires, you can organize them all at once without individual 

adjustments. After selecting the wires to sort, click  the button in the top edit layout and select 

the end to be the reference, and all wires are adjusted to their end points. 

 

Connector geometry 

Even if the connector has a library and a shape exists, it is not displayed when it is created in the 

drawing by default. However, if you click on the  feature in the top edit layout to activate the 

feature, you can see the shape of the connector in the drawing. 

 

 a twist 

The ability to invert selected shapes along horizontal or vertical axes. After you select the shape you 

want to invert, you can use the buttons  in the edit layout to select the axis, which reverses the 

shape based on the selected axis. 

 

scale 

The ability to shrink or enlarge the selected shape. After selecting the buttons in Shape and Edit 

Layout, you can adjust the scale by clicking the reference point and moving the mouse, or you can 

adjust it to the desired size by entering a value directly into the text box . However, the text is 

excluded from the scale target. 

 

Spinning 

Click the button in the edit layout  to rotate the shape in 90-degree increments. 
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Customization 

The function of aligning the selected features. After selecting all the features to sort, click the button 

in the edit layout  to select the alignment direction from left, right, top, and bottom. When you 

select a direction, the shapes are aligned based on that direction. 

 

Sorting 

This feature is available by clicking a button in the edit layout.  The ability to sort for selected 

features, if the customization is to align the baseline of the features, then the alignment is the task 

of sending the features forward or backward. This feature consists of a total of four options: 

 forward, forward, forward, backward, backward. 

 

Group 

The ability to group or release selected shapes. This feature only supports raw figures and does not 

support wiring elements. Select the features you want to apply and group them  by buttons in 

the edit layout. 

 

Utilities 

 

It is located at the top right of the home tab with a layout that brings together features to help design 

drawings. 

Find it 

Search for wiring elements present in the drawing. You can write down what you want to find and 

set up where to find, options, and more to navigate. It can be used as  Ctrl+F or as a button. 

 

Print 

Prints the drawing. 
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harness cord 

This button  is a harness code multi-input function. Specify the same harness code for all selected 

objects. 

 

Library Hotkey 

 

To open a window, click a button in the appropriate top utility layout.  Previously, applying 

libraries to Wire and Connector required access to the created object through a property window, 

and if there were multiple objects, you had to open and close repeatedly. However, this feature 

makes it easier to apply libraries to multiple objects by enabling separate library windows. 

The form remains open until it is closed, and you can use it as follows: Select the object you want 

to apply the library to, and repeat the process of specifying the library. You can select Connector 

and Wire through the combo box at the top left, and if no object is selected, you can also create 

a connector or wire with that library directly in the drawing. 
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Power distribution chart 

The power distribution chart is a visual representation of how power is distributed to each 

component or device within an electrical circuit or electrical system. It is a design showing the flow 

of electricity from the power supply to each element. Instead of drawing the circuit design of the 

power supply directly, if you pre-configure it in the form of a tree as shown in the picture below 

and specify the connection relationship between each connector and the element, it is automatically 

generated in the drawing. 

 

Create a project 

You can create, remove,  and edit projects using the button at the top or right-click. 

Organize items 

The power distribution of the project is also configured. It can be configured in a tree format, 

with the project name at the top, followed by power, connector, and device. You can connect 

the library by clicking the button in the Connector Library column. The basic configuration 

is set to have connectors under the power and elements under the connectors, and right-click 

to activate the tab that allows you to configure the tree. 
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■ For the Edit Name connector, you 

 can edit the name separately. 

 

■ You can configure 

 additional power distribution charts. 

When you select the connector or element you want to configure, call the list registered in 

the library to configure the tree. 

 

■ Delete tree components are deleted 

. If you delete an element of the list, the sub-items are also removed, and the pin list is 

initialized. 

■ Create a power distribution diagram in 

 the drawing that you have configured. 

■ Share. Specifies the selected connector. 

 The shared connector can be applied to other connectors. Through this function, it can 

be reused in multiple locations or configured by connecting with common data. 

 

■ Share Conversion Share Conversion function 

ality allows you to convert to a share connector. When you specify a share, you will share 

all the information (pin mapping). 
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pin mapping 

 

Select a connector or element configured in the power distribution to view the pin mapping 

table in the tab below. PinInfo is the information of the Pin currently held by the selected 

element and StartInfo is the pin information associated with the element at the parent node. 

The picture above illustrates that pin (3) of the 6189-1240 connector is connected to PIN1 of 

the element. End Info represents the end point of the pin. For example, if you select a blank 

space in the End Info column of PIN2 above, the following selection window appears. 

 

You can check all the pins on the MG643362-40 connector and check the check box in the Use 

column to complete the connection. 

Create Distribution Chart 

 

When the power distribution chart configuration is completed, the circuit is automatically 

generated in the drawing through the Create Distribution Chart button. 
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Windows 

 

List horizontally 

This feature is available when more than one diagram is active. When you click the button in the 

window layout, it is activated, and the original drawing tab shows that only one screen was visible 

at a time, divided horizontally and  divided into the screen by the number of open diagrams. 

This feature allows you to view and work with multiple diagrams simultaneously. 

 

List vertically 

When clicking the button in the window layout , it is the same as the horizontal listing function 

above, but this time, it is divided vertically. 

 

Back to tab group 

This feature can be utilized after using the horizontal or vertical listing function. Restore the diagram 

split by  the buttons in the window layout back to the top tab. 
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Panel 

 

Project 

 

The ability to hide or re-display the left project tab. By default, the Project tab is always visible, but 

if you want to hide the tab, you can  click it at the top of the project  tab or click a button in 

the top layout panel to the left side of the Hide&Show. To re-display the Hidden Projects tab, you 

can reactivate it by clicking on the button of the same function. 

 

Output window 

This function determines whether or not to activate the console window at the bottom.  It can be 

determined by the button, and the function  is displayed in the corresponding console window 

in text format on what works within the project. It usually displays information about system changes, 

such as activating diagrams or storing them. 

 

appearance 

 

Themes 

You can specify a background theme for CADvizor. In the tab on the left, in addition to the commonly 

seen White & Black themes, there are various types of themes, such as Office and VS, which change 

the color of the window and font depending on the type you choose. WhiteSmoke, Black, and 
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Default on the right change the theme of the drawing to the selected color. 

Grid 

 

Grid acts as a baseline by which objects can be aligned and placed in a drawing. This Grid allows 

the precise placement of circuit objects. The corresponding tab lets you adjust the alignment criteria 

of the drawing by setting the Grid interval. 

By default, the Grid interval is set to 2, and the user can select values such as 4, 8, 16, and so on. 

This interval determines how far apart objects are placed in the drawing, increasing the accuracy of 

the design and reducing interference between objects. 

After setting the Grid interval, it is generated to meet this criterion when creating circuit objects, 

allowing for more precise and consistent placement. 

 

DRC & Output 

 

On the Project tab, you can access "Right-click → Output" to create output based on the information you 

have designed. This feature allows you to design drawings within a project, then perform a Design Rule 

Check (DRC) check based on the design information and view the work history. 

Output generation is an important part of the design process, and after design is completed, errors are 

found and corrected through various verification operations. DRC checks are steps to ensure that the 

design conforms to the rules, which can ensure the quality of the final design. Work history also allows 

you to determine what modifications or tasks have occurred, making project management easier. 
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Build List Configuration & DRC 

 

Design rule checking (DRC) is a very important process in circuit design. This process ensures the 

accuracy of the design and improves the quality of the drawing by detecting errors in advance. 

1. Build list configuration: 

 Before you can proceed with the design rule check, you must configure the build list. A 

build list is a bundle for outputting a circuit diagram of a specific specification for each 

item. This allows you to select the design to conduct the inspection. When you select a 

project to run a design rule check and activate the check box for that design, the build list 

is complete. 

2. Design Rule Check Item: 

 The DRC checks multiple items to identify design errors. Key checks include: 

■ Check circuit object connection: Ensure that the designed circuit object is connected 

correctly. 

■ Check library presence: Verify that the parts used are defined in the library. 

■ Check harness code: Make sure harness code is applied correctly. 

■ Duplicate name search: Check for objects with the same name. 

■ Check mapping: Verify that the designed objects are mapped correctly. 

3. Warning and error messages: 

 If an alert or error is found during the DRC check, a message will be sent out. This message 

shows the location of the problematic drawing, and you can click the log to find and track 

it. This allows you to fix the problem quickly. 
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4. The importance of pre-checking: 

 Design rule checking is a must-do task before you get the output. DRC can help ensure 

the quality of the final design by proactively detecting and correcting errors. This is a very 

important validation task for improving the quality of drawing design. 

Therefore, early detection and correction of design errors through DRC is an important process to 

improve circuit design quality and ensure product reliability. 

 

Types of DRC 

Design rule checks are classified into six main categories, and you can specify whether each item is 

inspected or not through a checkbox. 

If a warning or error occurs during the examination, you can view the log for the problem. This 

allows you to check and supplement what you missed during the design process to create a more 

accurate and reliable drawing.  

Connectivity 

Check connectors and connector pin connections: 

 Check that the pin generated in the connector is connected properly 

Check for splice branch connections: 

■ Wires to be connected to the splice are missing. 

■ If the wires connected to the splice are inconsistent because they have different option 

definitions. 

■ If there is a discrepancy error in wire type such as thickness, material, current capacity, 

etc. 

Check wire from-to connectivity: 

■ Error for unconnected wires (in levitation status) 

■ Option Conflict Error 

■  

Consistency 

Check library input (part number or series): 

■ The registered part does not have a part number. 

■ The series information to which the part belongs is missing. 

Check unused options: 
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 Make sure that certain wires or parts are clearly used in which options. 

In-line connector Plug-Jack consistency check (number of cavities): 

■ When the pin placement of Plug and Jack is set differently. 

■ When the number of cavities in Plug and Jack does not match. 

■ Option conflict error. 

■ When the series or manufacturer of Plug and Jack is different. 

Check library connectivity: 

 If the circuit object in the drawing does not have a library. 

 

Custom 

Check connector reference wire harness cord differences: 

■ When the harness cords of wires connected to the same connector are different. 

■ When the same part but not consistent because they have different harness codes. 

■ Depending on the option, the harness code is defined differently, resulting in a 

collision. 

Check for harness cords: 

■ If the harness cord is not entered in the wire, connector, or wiring element. 

Check for color and cross sectional differences in wires connected to inline connectors: 

■ The cross-sectional area of the wire does not meet the current capacity of the 

connector or exceeds/believes the specification. 

■ The color and cross-sectional area do not match or do not match each other. 

■ If the color of the wires connected to the inline connector does not match. 

Check for material degradation of wires connected to inline connectors: 

■ If the materials of wires connected to the inline are different for reasons such as 

electrical compatibility, mechanical consistency (durable, resistant, sagging), etc. 

Check the plating phase of the wire connected to the inline connector: 

■ If the plating of the wire connected to the inline connector is different due to problems 

such as electrical performance degradation, corrosion occurrence, mechanical 

instability, etc. 
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Check mainline reference branch harness cord difference: 

■ The main line has a harness cord defined, but the branch line does not have a harness 

cord. 

■ If the harness cord of the main line and the branch line is different. 

■ If there is an error in the consistency of the harness cord at the splice or junction. 

■ If the harness code in the diagram is not automatically updated. 

Check the color difference of the main line reference branch line: 

■ Whether there is a color mismatch between the main line and the branch line due to 

possible confusion, wiring errors, and difficulties in maintenance. 

■ Color consistency at splice or bifurcation point. 

■ If the main line has color but the branch line is not specified in color. 

Check the consistency of branch line reference arrangement options: 

■ If the options of branch line and main line are different. 

■ If the main line has an option but the branch line does not have an option. 

■ When the option is changed, the relevant wires in the diagram are not reflected 

properly. 

Check for differences in cross-sectional area of mainline reference branch lines: 

■ When the cross-sectional area of the branch line and the main line is not properly 

established. 

■ Cross-sectional mismatch at splice and bifurcation points. 

■ If you have a cross-sectional difference in excess of a particular current capacity. 

 

Naming 

Check duplicate object names: 

■ The circuit object's name is not unique and overlaps with another object. 
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ElectricDevice 

Check duplicate element pin names: 

■ The same pin name exists within the same part. 

Check the location of the element: 

■ When more than one element is placed in the same coordinate. 

■ The minimum gap between parts is not maintained. 

■ If electrical interference is likely to occur. 

Check element pin mapping: 

■ The library data and the actual pin information are inconsistent. 

■ If the power and GND pins are incorrectly connected. 

Check the element pin wire/net connection: 

■ If the pin is not connected to the wire. 

■ An incorrect signal line is connected to the pin of the element. 

Check element pin power/ground: 

■ The power and ground pins are not connected to the circuit. 

■ No voltage is supplied to the VCC pin, or the GND pin is not grounded. 

Check the connection to the element library: 

■ The output pin is set to the input pin. 

■ The signal pin is connected to a power source. 

 

Net 

Redundant check of four names: 

■ When used repeatedly in different circuits. 

Check Net Drive Source: 

■ The drive source is not connected to the four. 

■ When connected to an unnecessary circuit or incorrect part. 

■ Multiple drive sources are connected to the same net at the same time. 
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Check the four and pin connection: 

■ If the pin is not connected to four. 

■ If you are connected to a wrong or unnecessary net. 

■ Physically connected, but power and signal four are wrong. 

Check for net connectivity: 

■ Four is not connected to any pin 

■ It is connected to the wrong part or to the wrong signal & ground net. 

■ If there is an element that may cause an electrical collision. 

4 Thickness check: 

■ When four thicknesses that do not meet the standard are used. 

 

output 

 

If the DRC check has been completed normally, you can now proceed with the output output. The 

deliverables list contains a variety of reports and data files, which provide a variety of information 

about the designed circuits. The outputs are mainly available in Excel format, and some are stored 

in specific formats. The list of key deliverables is as follows: 

1. Wire List: 

 A list containing information about all designed wires, which allows you to check the 

connection and characteristics of the wires. 

2. Wire List with Device— 

A list that contains information about the wires associated with the device, which allows you 

to track the wires associated with the device. 
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3. Netlist—A list that provides information about all net defined in the circuit. The net 

represents the electrical connection of the circuit, which allows you to check the status of 

the connected net. 

4. Connector list: 

 A list containing information about the designed connector, which allows you to view the 

connector's connection information and related data. 

5. Element list: 

 A list of all elements (parts) used, providing details for each element. 

6. Option list: 

 A list of options selected in the design, including electrical specifications of the wire, 

shielding, voltage and current. 

7. Symbol diagram: 

 A list that outputs diagrams of designed symbols, which are usually stored in .dxf format. 

This format can be used in CAD programs to help you visually check your drawings. 

All of these outputs are classified by harness code so that parts belonging to a particular harness 

code can be checked and managed separately. By outputting the output in Excel format, data can 

be easily analyzed and managed, and the symbol stored in .dxf format can be utilized for CAD 

drawings. 

  



46 

 

Configuration Settings 

Low resolution display resolution settings 

 

If the resolution is low, the display resolution settings must be specified separately. Here's how to 

set up your system. 

1. Right-click the desktop CADvizor execution icon 

2. Click "Properties" in the menu 

3. "Compatibility" tab → "Change high DPI settings" in the Properties pane 

4. Set the "Override High DPI Adjustment" part of the Settings window 

■ "Override High DPI Adjustment Behavior" Check 

■ Change to "Application" → "System (Advanced)" 

5. Desktop → Right-click →→ Display Settings 

6. Change the setting values in the text app and other items resize menu (set according to 

your screen) 

 

Network connection 

If a program is not used for a long time or the network environment is unstable, the connection to 

the server may be lost, resulting in limitations in functionality. At this time, if the program does not 

work properly or needs to be reconnected during the operation,  you can use the account 
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information by pressing the button at the top right to reconnect. This will help you resolve 

connectivity issues and keep working smoothly. 
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Contact CADvizor 

Room A-1106, U-Space, 660, Daewangpangyo-ro, Bundang-gu, Seongnam-si, Gyeonggi-do 

Yura IT Business Division Development Team 2 

13494 

Phone: 070-7878-7082 

Website: http://www.cadvizor.com 

 

Sales Information 

If you want to purchase additional CADvizor products, please contact your agency or head office 
directly. 

 

Technical Support 

If you have any technical inquiries about the product and any inconvenience in using it, please 
contact us by e-mail below. 

Email: cadvizor@gmail.com 

 

Feedback 

If you have any improvements or errors regarding CADvizor, please feel free to contact us. 

http://www.cadvizor.com/
mailto:cadvizor@gmail.com

